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Download Links

While this document shows how to setup and install a VirtualBox environment for use of a Linux virtual
machine for the cross-build platform, downloads are large. It is recommended to begin all downloads
ahead of time to save time later when continuing the instructions in this document. The download links
are also interleaved in the appropriate locations IN this document, however, it is recommended to
download all files early as they can take quite some time.

VirtualBox and Extension Pack Downloads:

https://www.virtualbox.org/wiki/Downloads
1. Platform package for Windows hosts (~110 MB)
2. Extension pack (~20 MB)

Vivado and SDK (NOT needed for Avnet Technical Training Courses):

https://www.xilinx.com/support/download/index.html/content/xilinx/en/downloadNav/vivado-design-
tools.html
Vivado HLx All OS installer single-file download recommended (~17 GB)
or use the Linux self-extracting web installer (~100 MB), which downloads the rest during install
Note that you do not need the Updates unless you need specific support for the devices included in those
updates.

-OR-

SDSoC (includes Vivado and SDK):

https://www.xilinx.com/support/download/index.html/content/xilinx/en/downloadNav/sdx-
development-environments.html
SDx SFD download recommended (~20 GB)
or use the Linux 64 web installer (~100 MB), which downloads the rest during install

Note that you will need an SDSoC license. If you only plan on using Vivado and SDK, there is NO need to
download the SDSoC installer. If you are planning to use SDSoC, then it is strongly recommended to
install the SDSoC installer ONLY, as this will include the Vivado HLS install, SDK, as well as the SDx
extensions for the Eclipse environment.

The Petalinux Installer:

https://www.xilinx.com/support/download/index.html|/content/xilinx/en/downloadNav/embedded-
design-tools.html
Download Petalinux Installer (~6 GB)

Ubuntu ISO:
Please refer to the latest copy of UG1144, to identify which revision of Ubuntu is supported. Choose the
latest update for that version, which as of this writing is 16.04.05.

http://www.ubuntu.com/download/desktop
http://releases.ubuntu.com/xenial/ubuntu-16.04.5-desktop-amd64.iso
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When complete, you should see something like below, along with either Xilinx Vivado/SDK or SDSoC
installation archive.

MName B Size

ﬁ Oracle_VM_VirtualBox_Extension_Pack-6.0.4.vbox-extpack 22 745 KB
| | petalinux-v2018.3-final-installer.run 7,118,756 KB
|2 ubuntu-16.04.5-desktop-amdBd.iso 1,610,928 KB
|| VBoxGuestAdditions_6.0.4.is0 83,904 KB
8¢ VirtualBox-6.0.4-128413-Win.exe 214,503 KB
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Preparing Your Machine

For best results with using VirtualBox Virtual Machines (VMs) as depicted in this document, some
preparation of your machine is required to enable virtualization extensions for your CPU within the
system BIOS (or UEFI) and to make sure that no conflicting virtualization packages are loaded.

Enabling CPU Virtualization Features:

The system BIOS (or UEFI) of a PC is responsible for enabling virtualization extensions and features of
CPUs that support Virtualization Technology (VT). This is important because workstation and
development workloads can co-locate while maintaining full isolation from each other. They can also
freely migrate across infrastructures and scale as needed.
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To enable your CPU virtualization extensions, you will need to reboot your PC and enter the (BIOS or
UEFI) configuration menu. This often involved holding down a special key during the early stages of
booting the PC, so you may need to refer to the manufacturer documentation for your specific model of
PC or motherboard to know which key is needed to enter the configuration screen. Once in the
configuration screen, look for the Intel VT-x, Intel Virtualization Technology, or Virtualization
Extensions options and make sure that they are enabled. Again, model specific PC manufacturer
documentation may help here with locating the correct settings.

For further information on enabling virtualization features on the CPU of your development machine,
there are other resources that provide guidance:

https://www.howtogeek.com/213795/how-to-enable-intel-vt-x-in-your-computers-bios-or-uefi-
firmware
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Disabling Windows 10 Hyper-V:

Windows 10 Pro includes Microsoft provided VM enablement called Hyper-V. However, Hyper-V and
VirtualBox cannot be used concurrently. The Hyper-V feature of Windows needs to be disabled to use
VirtualBox. If Hyper-V is enabled VirtualBox may still run to a point and then VM will likely hang without
any explanation from VirtualBox that Hyper-V is still enabled.

If more advanced users want to run Docker for Windows, it will require Hyper-V instead of VirtualBox.
The following dialog is where many Windows 10 features can be enabled/disabled, you can find it from

the Win 10 search bar with the “Windows Features” search string and Hyper-V can be disabled by
removing the checkmarks next to these features:

&

Turn Windows features on or off [ 7]

To turn a feature on, select its check box, To turn a feature off, clear its
check box. A filled box means that only part of the feature is turned on.

7 @] | .MET Framework 3.5 (includes .NET 2.0 and 3.0} A
MET Framework 4.6 Advanced Services
Active Directory Lightweight Directory Services

T

Ermbedded Boot Experience
Embedded Logon
Embedded Shell Launcher
Hyper-V
Hyper-Y Management Tocols
Hyper-V Platform
Internet Explorer 11
1 [ Internet Information Services
1 Internet Informatinn Senvices Hostahle Webh Core

Cancel

7 = K000 0] =

Microsoft has also provided an answer on the topic of disabling Windows 8 and Windows 10 Hyper-V.

https://answers.microsoft.com/en-us/windows/forum/windows 8-windows install/how-do-i-uninstall-
hyper-v/7d268911-47cd-4c52-bfe5-ea41e58067ab
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Installing Oracle VM VirtualBox on Windows

This document shows how to install VirtualBox and the Extension Pack to enable the use of a Linux
virtual machine for the cross-build platform.

General Instruction:

Install Oracle VM VirtualBox using the official VirtualBox installer. For legal distribution reasons, the
VirtualBox installation executable cannot be included with any public Avnet materials. To obtain a free
legal copy of the Oracle VM VirtualBox and the Extension Pack, please download from the VirtualBox
website:

https://www.virtualbox.org/wiki/Downloads

The version downloaded may differ from the version shown in this documentation (5.2.26). Be sure to
read the VirtualBox EULA to ensure you do not violate the Personal Use and Evaluation License (PUEL).
You may also wish to consult the VirtualBox Licensing Frequently Asked Questions for a quick overview
of the intent of the license agreements:

https://www.virtualbox.org/wiki/Licensing FAQ

Step-by-Step Instructions:
1. To obtain a free legal copy of Oracle VM VirtualBox, download the installer from this website:

https://www.virtualbox.org/wiki/Downloads

The version downloaded may differ from the version shown in this documentation (5.2.26). You
also need to download the Extension Pack which is a separate download. Make sure the
Extension Pack you download is the same version as your VirtualBox installer.

2. Launch the VirtualBox installer from Windows Explorer by double-clicking the self-extracting
executable. Allow the installer to make changes to your computer, if so prompted.

Mame Date modified Type Size

ﬁ VirtualBox-5.2.26-128414-Win.exe 3/5/201910:52 AM Application 111,781 KB
VirtualBox Installer for Windows
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3. Once the VirtualBox installation wizard appears, click the Next button.

4 Oracle VM VirtualBox 5.2.26 Setup [

Welcome to the Oracle VM
VirtualBox 5.2.26 Setup
Wizard

The Setup Wizard will allow you to repair your current
installation or remove Orade VM VirtualBox 5.2.26 from your
computer. Click Mext to continue or Cancel to exit the Setup
Wizard.

Version 5.2.26

4. You may accept all the installation defaults, although you may wish to change the installation
location on your development platform using the Browse button. If the options are acceptable,

click the Next button.

1 Oracle VM VirtualBox 5.2.26 Setup _-— [

Custom Setup
Select the way you want features to be installed.

Clidk on the icons in the tree below to change the way features will be installed.

""" i Orade WM VirtualBox 5.2.28 |
<= ~ | VirtualBox USE Support application.
<= | VirtualBox Netwarking

e =0 = | VirtualBox Brid
‘ gil ?r al OHSEER s feature requires 175MBE on
e r | VirtualBox HostC) iy - hard drive, Tt has 3 of 3

o (0 = | VirtualBox Python 2 5L|  subfeatures selected. The
subfeatures require 864KE on yo...

2

4 (L 2

Location: C:\Program Files\Orade\VirtualBox\,

Version 5.2.26 [Diskgsage] [ < Back ][ Mext = ] [ Cancel ]
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5. You may again accept the default options and click the Next button.

.
j’f?‘ Cracle VM VirtualBox 5.2.26 Setup

===

Custom Setup
Select the way you want features to be installed.

Please choose from the options below:

[¥|Create start menu entries:

Create a shortcut on the desktop
Create a shortcut in the Quick Launch Bar

Register file assodations

Version 5.2.26 < Back ][ Mext = ]

l Cancel

6. Click the Yes button to continue with the installation wizard.

3 Oracle VM VirtualBox 5.2.26

Warning:
Network Interfaces

disconnect you from the netwark.

Proceed with installation now?

Installing the Orade VM VirtualBox 5. 2. 26 Networking
feature will reset your netwark connection and tempararily

Version 5.2.26 [ Yes
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7. Click the Install button to load VirtualBox to your development system.

Ready to Install
The Setup Wizard is ready to begin the Custom installation.

Click Install to beqin the installation. If you want to review or change any of your
installation settings, dick Badk. Click Cancel to exit the wizard.

Version 5.2.26 < Back ” Install l [ Cancel

8. During the installation you may receive prompts to authorize installation of various
components. If prompted, allow the installer to make changes to your system, including
installation of the USB interface and Network adapters.

Oracle VM VirtualBox 5.2.26

Please wait while the Setup Wizard installs Orade WM VirtualBox 5.2.26. This may
take several minutes,

Status:

Version 5.2.26
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9. If you are asked to install the Oracle Corporation Universal Serial Bus device driver, or Oracle
Corporation Network Adapters/Network Service, choose to install them

Would you like to install this device software?

Mame: Oracle Corporation Universal Serial Bus ...
o Publisher: Oracle Corporation

[C] Always trust software from "Oracle Corporation”, Install H Don't Install

'i:' You should only install driver software frem publishers you trust. How can I decide
which device software is safe to install?

Would you like to install this device software?

Publisher: Oracle Corperation

L- Mame: Oracle Corporation Metwork adapters
.
==

[T Ahways trust software from "Oracle Corporation”. Install ][ Don't Install

'tf" You should enly install driver software from publishers you trust. How can I decide
which device software is safe to install?

Would you like to install this device software?

D Mame: Oracle Corporation Metwork Service

Publisher: Oracle Corporation

[T] Always trust software from "Oracle Corporation”. Install ][ Don't Install

'tf" You should only install driver software frem publishers you trust. How can [ decide
which device software is safe to install?

ANVNET
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10. Click the Finish button to complete the installation. Leave the checkbox enabled so VirtualBox
will start after the installer finishes.

Oracle VM VirtualBox 5.2.26
installation is complete.

Click the Finish button to exit the Setup Wizard.

Start Orade VM VirtualBox 5. 2. 26 after installation

Version 5.2.26

11. Once VirtualBox starts (you can also start it from the Desktop shortcut, or the Windows Start
button), the Extension Pack must be added. From the main menu, select File > Preferences.

File | Machine Help
& Preferences... Ctil+G ? HEE
&) Import Appliance... Ctrl+1 Machine Tools | | Global Tools
@ Export Appliance.. Cti+E Nelcome to VirtualBox!
Virtual Media Manager... Ctrl+D the left part of this window lists all virtual machines and virtual machine groups on your computer. The
Host Network Manager... Carle W t is empty now because you haven't created any virtual machines yet.
£ Network Operations Manager order to create a new virtual machine, press the New button in the main tool bar located at the top

P et i the window.
@ Check for Updates...

; u can press the F1 key to get instant help, or visit www. virtualbox.org for more information and

A\ ResetAll Warnings test news.
¢ Exit Crl+Q

ANVNET
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12. Select Extensions. Right-click in the Extension Packages whitespace box and select Add Package.

r ~
éb VirtualBox - Preferences @I&J

General Extensions

I

Input Extension Packages

Active Name Version
Update B

Language
Display
Network

Extensions

Prosy

EGedc

[ OK ][ Cancel ]

13. Browse to the location where you downloaded the VirtualBox Extension Pack compatible with
your VirtualBox version. Select the Extension Pack and click the Open button.

Mame Date modified Type Size

'ﬁ Oracle_VM_VirtualBox_Extension_Pack-5.2.26 vbox-extpack  3/5/2019 10:52 AM VirtualBox Extensi... 19223 KB

14. Click the Install button to add the VirtualBox Extension Pack.

ré!’ VirtualBox - Question l P |

You are about to install a VirtualBox extension padk. Extension
packs complement the functionality of VirtualBox and can contain
system level software that could be potentially harmful to your
system. Please review the description below and anly proceed if you
have obtained the extension pack from a trusted source.

Mame: Oracle VM VirtualBox Extension Pack
W Version: 5.2.26r1253414

Description: USBE 2.0 and USE 3.0 Host Controller, Host
L Webcam, VirtualBox RDP, PXE ROM, Disk

Encryption, NVMe.

Install ] [ Cancel
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15. Read the VirtualBox Extension Pack PUEL License to ensure you will not be in violation of the
Oracle definition of Personal Use. See the VirtualBox Licensing Frequently Asked Questions for
additional details. If you can accept the license conditions, scroll to the bottom of the
agreement text box and click the | Agree button?. If prompted, allow the installer to make
changes to your development system.

r |
7 VirtualBox License e E——— N — - [ ? iz-l
VirtualBox Extension Pack Personal Use and Evaluation License (PUEL) -

License version 10, 20 July 2017

PLEASE READ THE FOLLOWING ORACLE VM VIRTUALBOX EXTENSION PACK PERSONAL USE AND
EVALUATION LICENSE CAREFULLY BEFORE DOWNLOADING OR USING THE ORACLE SOFTWARE. THESE
TERMS AND CONDITIONS CONSTITUTE A LEGAL AGREEMENT BETWEEN YOU AND ORACLE.

m

ORACLE AMERICA, INC. ("ORACLE") IS WILLING TO LICENSE THE PRODUCT DEFIMED IN SECTION 1 BELOW
OMLY OM THE CONDITIOM THAT YOU ACCEPT ALL OF THE TERMS CONTAINED IN THIS VIRTUALBOX EXTEMSION
PACK PERSOMAL USE AND EVALUATION LICENSE AGREEMENT (“AGREEMENT”).

IF YOU ARE AGREEING TO THIS LICEMSE ON BEHALF OF AN EMTITY (RATHER THAM AS AM INDIVIDUAL HUMAN
BEING), YOU REPRESENT THAT YOU HAVE THE APPROPRIATE AUTHORITY TO ACCEPT THESE TERMS AND
CONDITIONS ON BEHALF OF SUCH ENTITY.

§ 1 Subject of Agreement. This Agreement governs your use of the binary software package called "Orade VM
VirtualBox Extension Pack” (the "Product”), which contains a set of additional features for "Crade VM VirtualBox”
that enhance the operation of multiple virtual machines {"Guest Computers”) on a single physical computer ("Host
Computer”). The Product consists of executable files in machine code, script files, data files, and all documentation
and updates provided to You by Orade.

§ 2 Grant of license. Orade grants you a personal, non-exdusive, non-transferable, limited license without fees

to reproduce, install, execute, and use internally the Product on Host Computers for your Personal Use,

Educational Use, or Evaluation. "Personal Use” is noncommercial use solely by the person downloading the Product
from Oracle on a single Host Computer, provided that no more than one dient or remote computer is connected to
that Host Computer and that dlient or remote computer is used solely to remotely view the Guest Computer(s).
“Educational Use” iz any use by teachers or students in an academic institution (schools, colleges and universities)

as part of the institution's educational curriculum. "Evaluation” means testing the Product for up to thirty (30)

davys; after expiry of that term, you are no longer permitted to use the Product. Personal Use and/or Educational =

[ I Agree ” I Disagres ]

16. Click the OK button to complete the installation.

¢ VirtualBox - Information @léj

The extension pack
Oracle VM VirtualBox Extension Pack
was installed successfully.

1 1f you must disagree, the installation will be terminated. You should either purchase a commercial license or
uninstall VirtualBox from your host computer.

ANVNET
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17. Click the OK button to return to VirtualBox.

i ee——— i |
% VirtualBox - Preferences &lﬂ—hj

@ General Extensions
@ Input Extension Packages

Active Mame Version
@ Update - -

& Oracle VM VirtualBox Extension Pack 5.2.26r128414
@ Language
Display
@ Metwork
G Extensions
Proxy

[ 0K ] [ Cancel

This completes the installation of VirtualBox on your host development system. VirtualBox is now ready
to accept a new Virtual Machine.

AVNET
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Create a New Virtual Machine

1. Launch Oracle VM VirtualBox Manager and click the New icon at the upper left.

Bile  Machine

Help

G B vD

Mew Settings Discard Start

l@, General

Marme:

Cineratinn Suetam:

2. Select a descriptive name for the VM. Set the Type to Linux and the Version to one that
corresponds to the OS you wish to install.

a. For Ubuntu, choose Ubuntu (64-bit).

-

T Lo a—
) Create Virtual Machine

Name and operating system

Please choose a descriptive name for the new virtual machine and select the
type of operating system you intend to install on it. The name you choose will
be used throughout VirtualBox to identify this machine.

Mame: |Ubuntu Petalinux 2018.3

Type: [Linux

-
Version: |Ubuntu (54-bit) 7

Expert Mode ] [ Mext

l [ Cancel

ANVNET
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3. Select the amount of memory to be allocated to the Virtual Machine. Allocating more memory?
will improve the VM performance, but you must leave enough memory available for your host
system for all other concurrent processes. For a host system with 16 GB of RAM, a value of
8192 MB is recommended for the Virtual Machine, especially if you intend on using Xilinx
SDSoC. You may wish to experiment with this value to optimize your performance as larger
density target devices have higher? memory requirements. The memory can also be changed at
any time even after installing the VM hosted OS. You will need to locate a balance of host and
guest performance through properly balancing this. Of course, the MORE memory you can
provide the guest, WITHOUT causing issues for the host, the better your guest OS will run!

W Wddl mgernrie,
The recommended memory size is 1024 MB,
' ' () g192] = MB

4 Mg 16334 ME

4. Click the Create® button to accept the default file type for a VirtualBox Disk Image and allocate a
virtual hard drive now.

-

@ Create Virtual Machine

Hard disk

If you wish you can add a virtual hard disk to the new machine. You can either
create a new hard disk file or select one from the list or from another location
using the folder icon.

If you need a more complex storage set-up you can skip this step and make
the changes to the machine settings once the machine is created.

The recommended size of the hard disk is 10.00 GB.

) Do not add a virtual hard disk

@ Create a virtual hard disk now

) Use an existing virtual hard disk file

Empty

2 You may need more memory if you intend to run Vivado with large Xilinx devices.
3 If you are importing an existing Virtual Machine, click the “Use an existing...” button.

IAVNET
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5. Select Next, leaving the defaults for Hard disk file type

Hard disk file type

Please choose the type of file that you would like to use for the new virtual hard disk. If you
do not need to use it with other virtualization software you can leave this setting

unchanged.

@ VDI (VirtualBox Disk Image)
) VHD {Virtual Hard Disk)
(7)) VMDK (Virtual Machine Disk)

6. Select Fixed Size for the physical storage on your host hard drive. This will improve overall
performance of the Virtual Machine.

Storage on physical hard disk

Flease choose whether the new virtual hard disk file should grow as it is used {dynamically
allocated) or if it should be created at its maximum size (fixed size).

A dynamically allocated hard disk file will only use space on your physical hard disk as it
fills up (up to a maximum ficed size), although it will not shrink again automatically when

space on itis freed.

A fixed size hard disk file may take longer to create on some systems but is often faster to
use.

™) Dynamically allocated

@ Fixed size

INVNET
16 May 2019
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7. Select the name and location for the Virtual Machine within your host file system. The
recommended size is at least 300.00 GB to accommodate the Xilinx tools. If this space is
unavailable, 150.0 GB is the very least amount and will require frequent project cleanings to
make room for new projects. Click the Create button.

File location and size

Flease type the name of the new virtual hard disk file into the box below or dick
on the folder icon to select a different folder to create the file in.

Ubuntu Petalinux 2018.3 | &

Select the size of the wvirtual hard disk in megabytes. This size is the limit on the
amount of file data that a virtual machine will be able to store on the hard disk.

]
|

4.00 MB 2.00TE

The Virtual Hard Disk may take a few minutes to create and initialize on your host file system.

‘ Creating fixed medium storage unit 'C: Yisers', ‘AppData.ocal\Drosd<ewms\Ubuntu Petalinux 2018. 2 buntu Petalinux 201 vdi ...

x % X
\. J 57 seconds remaining

AVNET
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8. Once the Virtual Disk completes, select the newly created VM and click on the Settings button
to open the Settings dialog specific to the VM instance.

Q’ = 0O x

L /w_w?

* W P & | Ml -
Mew Settings Discard Start Machine Tools Global Tools
@. I Welcome to VirtualBox!

The left part of this window lists all virtual machines and virtual machine groups on your computer, N

The right part of this window represents a set of tools which are currently opened (or can be opened)

_—
for the currently chosen machine. For a list of currently available tools chedk the corresponding menu

at the right side of the main tool bar located at the top of the window. This list will be extended with

new tools in future releases.

‘fou can press the F1 key to getinstant help, or visit www.virtualbox.org for more information and

latest news.

9. Under the System blade and the Processor tab, select the number of logical CPU cores to be
allocated to the Virtual Machine. Allocating more CPU cores will improve the VM performance,
but you must leave sufficient CPU cores available for your host system for all other concurrent
processes. For a host system with 8 CPU cores, a value of 4 CPU cores is recommended for the
Virtual Machine, especially if you intend on using Xilinx SDSoC. You may wish to experiment with
this value to optimize your performance as larger density target devices have higher?
computation requirements for design placement. The memory can also be changed at any time
even after installing the VM Guest OS as long as the Guest is shut down and the VM powered
off. You will need to locate a balance of host and guest performance through properly balancing

this.
£73 Ubuntu Petalinux 2018.3 - Settings (-2 [
@ General System
IE System Processor | Acceleration
Display Processor(s): 0 4 =
1CPU 3 CPUs
@ Storage =
Execution Cap: r,} 100% [+
{Ba Audio 1% 100%
Extended Features: [ | Enable PAE/MX I
@ Metwork
@ Serial Ports '
ﬁ LsE
|j Shared Folders
EI User Interface

OK ] [ Cancel
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10. Once the processor allocation has been modified in the above step, your VM is ready to accept
an operating system.

5 oste vt M M W L e

File  Machine Help

My -~ =
51@3 {5} 4 3 @ [} Details ﬁg% <
Mew Settings Discard Start h u Machine Tools Global Tools

= General = Preview i
MName: Ubuntu Petalinux 2013.3

Operating System:  Ubuntu (64-bit)

m System

Base Memory: 3192 MB Uhuntu PEtal-inux

Boot Order: Floppy, Optical, Hard Disk
Acceleration:  VT-x/AMD-V, Mested Paging, KVM Paravirtualization

2018.3

Display

Video Memory: 16 MB

Remote Desktop Server:  Disabled =
Video Capture: Disabled

Storage

Controller: IDE
IDE Secondary Master:  [Optical Drive] Empty
Controller: SATA
SATA Port 0: Ubuntu Petalinux 2018, 3.vdi (Mormal, 500.00 GB)

{2 Audio

Host Driver:  Windows DirectSound
Controller:  ICH ACS7

=P MNetwork
Adapter 1:  Intel PRO/1000 MT Desktop (MAT)
> use M

USE Controller:  OHCI, EHCI
Device Filters: 0 (0 active)

[l Shared folders =

ANVNET

Reach Further™ 19 May 2019



VirtualBox and VM Creation Xilinx Vivado®/SDK/PetaLinux/SDx 2018.3

Install the Ubuntu 16.04 Operating System

To perform the steps in this section, you will need to download a bootable OS image in .iso format to
your host system. While Ubuntu 17.04 is the latest, Ubuntu 16.04.2 is the recommended version
(ubuntu-16.04.2-desktop-amd64.iso). We have also seen other sub versions of Ubuntu 16.04 work with
this. The Ubuntu images can be downloaded from:

http://www.ubuntu.com/download/desktop

1. Launch VirtualBox (if necessary) and select the VM you wish to start in the left-hand panel. Click
the Start button to execute the VM.

§ Oracle VM VirtualBox Managt
File

Machine Help

* B P

Mew Settings Discard Start

£ =
© Mai

[=a

2. Select the Browse a3 icon to locate the .iso image for the OS you wish to install on your Virtual
Machine. Click the Start button to begin.

Please select a virtual optical disk file or a physical optical drive
containing a disk to start your new virtual machine from.

The disk should be suitable for starting a computer from and should
contain the operating system you wish to install on the wvirtual machine
if you want to do that now. The disk will be ejected from the wirtual
drive automatically next time you switch the virtual machine off, but
you can also do this yourself if needed using the Devices menu,

|u|:uun1J.|-16.El4. 2-desktop-amd&4.iso (1.45 GB)

| start
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3. When the Install Welcome screen appears, select English and click the Install Ubuntu button.

Install (as superuser)

Welcome

[English |

Espariol *
Esperanto

Euskara

Francais

Gaeilge

Galego

Hrvatski

Islenska —

Italiano

Kurdi Try Ubuntu Install Ubuntu

Latviski - -

Lietuviskai

Magyar ‘You can try Ubuntu without making any changes to your computer, directly from
this CD.

Nederlands

Norsk bokmal Orif you're ready, you can install Ubuntu alongside (or instead of) your current

Norsk nynorsk operating system. This shouldn't take too long.

Polski

Portugués .

- . You may wish to read the release notes.

4. If at any point you find the display is too small, such that the buttons are outside the field of
view, you can click and drag the window to bring it into view. Although not very visible, there is
a banner area immediately to the right of the “Install (as superuser)” text. Click and hold your
mouse in that top banner area and drag the window so the buttons come in view. We will adjust
the display later.

5. Theinstaller shows requirements for installation. The two options can be left unchecked. Click
the Continue button.

Install (as superuser)

Preparing to install Ubuntu

Download updates while installing Ubuntu

This saves time after installation.

Install third-party software for graphics and wi-Fi hardware, Flash, MP3 and other media
This software is subject to license terms included with its documentation. Some is proprietary.

Fluendo MP3 plugin includes MPEG Layer-3 audio decoding technology licensed from Fraunhofer 115 and Technicolor SA.

Quit Back Continue
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6. The installer displays various installation types. The default displays as Erase disk and install
Ubuntu. Click the Install Now button.

Install (as superuser)

Installation type

This computer currently has no detected operating systems. What would you like to do?

© Erasedisk and install Ubuntu
‘Warning: This will delete all your programs, documents, photos, music, and any other files in all operating systems.

Encrypt the new Ubuntu installation for security
‘You will choose a security key in the next step.

Use LVM with the new Ubuntu installation
This will set up Logical Volume Management. It allows taking snapshots and easier partition resizing.

Something else
‘You can create or resize partitions yourself, or choose multiple partitions For Ubuntu.

Quit Back Install Now

As this is a new installation, we want all changes written to the disks. Click the Continue button.

© Write the changes to disks?

IF you continue, the changes listed below will be written to the disks. Otherwise, you will be able to make Further
changes manually.

The partition tables of the following devices are changed:
SCsI3 (0,0,0) (sda)

The Following partitions are going to be formatted:

partition #1 of SCs13 (0,0,0) (sda) as ext4
partition #5 of SCSI3 (0,0,0) (sda) as swap

Go Back Continue

7. Select your time zone and click the Continue button.

Install (as superuser)

Where are you?

Phoenix

Back Continue
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8. Select your preferred keyboard layout option. The default displays as English (US). Click the
Continue button.

Install (as superuser)

Keyboard layout

Choose your keyboard layout:

English (Ghana) Englshus) |

English (Nigeria) English (US) - Cherokee

English (South Africa) English (US) - English (Colemak)

English (UK) English (US) - English (Dvorak alternative international no dead keys)
a English (US)-English (Dvorak)

Esperanto English (US) - English (Dvorak, international with dead keys)

Estonian English (US) - English (Macintosh)

Faroese English (US) - English (Programmer Dvorak)

Filipino English (US)-English (US, alternative international)

Type here to test your keyboard

Detect Keyboard Layout

Back Continue

For the purposes of this tutorial, we will use a User ID (uid) of training. This will also set the default
Group ID (gid) to training. Feel free to change references to training as the uid or gid to a different name
of your choosing.

9. Enter the primary user name for the Virtual Machine in field “Your name” as training. The
system will auto-populate the computer name and username. Enter and confirm any password
of your choosing, but please remember what this is. Click the Continue button.

Install (as superuser)

Who are you?

2
=

Your name: | training

Your computer's name: | training-VirtualBox o

The name it uses when it talks to other computers.

Pick a username: | training o
Choose a password: | 900009 Short password
Confirm your password: .....| v

Log in automatically
© Require my password to login
") Encrypt my home folder

Back Continue
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10. The installation displays a Welcome graphic and proceeds with installation. When the
installation is complete, a screen appears asking you to restart. Click the Restart Now button.

If the Restart appears to “freeze”, you can force a reboot manually:
a. From the main VirtualBox menu, select File | Close.
b. Inthe Close Virtual Machine dialog, select Power off the machine and click the OK
button.
c. Inthe Oracle VM VirtualBox Manager, select your Virtual Machine and click the Start
button.
If Ubuntu requests that you remove the installation media and press enter to continue, it is
easiest to select Devices-> Insert Guest Editions CD image...

Devices | Help

=) Optical Drives r
g Audic 2
P Network b
¥ UsB b
@ Webcams r
[ Shared Folders ’
[T] Shared Clipboard 2
Y Drag and Drop ’
& Insert Guest Additions CD image...
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Configuring VirtualBox for Better Ease of Use

Configuring VirtualBox on a supported Linux system should be straightforward but depending on the
precise hardware configuration of your development system, there could be some challenges to create
an optimal environment. This section outlines a few of the common issues that may be encountered
along with some suggested workarounds to help increase the ease of use for the environment.

Adjust Display Preference

PwnNPE

Select File > Preferences

Select the Display blade

Set the Maximum Guest Screen Size to Automatic.
Click OK.

VirtualBox Guest Additions Installation (File Sharing)

The use of shared folders allows for easy transfer of files between the host and guest systems.
To use the shared file facility of VirtualBox, you must install the Guest Additions
(VBoxGuestAdditions_5.1.22.iso). If you attempt to use the shared folder facility without the
Additions, you will receive the following error message.

-

i VirtualBox - Warning w 2

The VirtualBox Guest Additions do not appear to be

! 4, available on this virtual machine, and shared folders
cannot be used without them. To use shared folders
inside the virtual machine, please install the Guest
Additiong if they are notinstalled, or re-inztall them if
they are not working correctly, by selecting Insert
Guest Additions CD image from the Devices
menu. If they are installed but the machine is not yet
fully started then shared folders wil be available
once it is.

Do not show this message again

After Guest Additions are installed, you can move the cursor between the Virtual Machine and
the host OS without having to use the Right Ctrl key to recapture the cursor in the host.
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2.  From the Devices menu, select Insert Guest Additions CD image...

@ Ubuntu Petalinux 2017.2 [Running] - Cracle VM VirtualBox _
File  Machine View Input | Dewvices | Help
Ubuntu Desktop Optical Drives

Metwork
UsSE
Webcams

Shared Folders

Shared Clipboard
Drag and Drop

| Insert Guest Additions CD image...

3. Click the Run button to execute the installation.

“VBOXADDITIONS_5.1.22_115126" contains
software intended to be automatically started.
Would you like to run it?

IF you don’t trust this location or aren’t sure, press Cancel.

Cancel Run

4. Note, if this does not auto-run
a. open aterminal
b. cd/media/training/Vbox_Gas_5.2.26
c. sudo ./autorun.sh
Enter your root password
d. Skip to the “VirtualBox Shared Folders” section
5. Enter the root password (the password that was created for the default user) and click the
Authenticate button.

x Authenticate

Authentication is needed to run '/bin/sh' as the super user

d'%%  An application is attempting to perform an action that requires
privileges. Authentication is required to perform this action.

Password:

+ Details

Cancel Authenticate

6. The Guest Additions should install and verify with no failures.
a. If this does fail, reboot and attempt the same procedure to install the Guest Additions

AVNET

Reach Further™ 26 May 2019



VirtualBox and VM Creation Xilinx Vivado®/SDK/PetaLinux/SDx 2018.3

7. If theinstallation states that it needs to be reset before kernel modifications can occur, do so
and then come back

8. Press the Enter key to close the installation window.

oY

Terminal

Verifying archive integrity... All good.
Uncompressing VirtualBox 5.1.22 Guest Additions for Linux
VirtualBox Guest Additions installer

Copying additional installer modules ...

Installing additional modules ...

vboxadd.sh: Starting the virtualBox Guest Additions.
Press Return to close this window...

9. Restart Linux to ensure that the Guest Additions is started properly. Press the settings “Gear” in

I
the upper right -- . Select Shut Down... and then click the Restart icon.

Sshut Down

Goodbye, training. Are you st e you wank to
close all programs and shut down the computer?

Resktart
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Adjust Display Resolution

1. Once rebooted, log back in.

2. Click on the System Settings icon.
Ubuntu Desktop

PDPD o H

(o 0 Yo

3. Select the Displays icon

—
—"

Displays

INVNET
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4. Adjust the resolution to your desired setting for your monitor. Then click Apply.

2560 x 1600 (16:10)
1920 x 1440 (4:3)
1920 x 1200 (1§:10)
1920 x 954 K
1856 x 1392 (4:3)
1792 x 1344 (4:3)
1680 x 1050 (16:10)
1600 x 1200 (4:3)
1440 x 900 (16:10)
1400 x 1050 (4:3)
1360 x 768 (16:9)
1280 x 1024 (5:4)
1280 x 960 (4:3)

1280 x 800 (16:10)
1280 x 768 (16:10)

L1157 v RAA (A-2)

5. If everything looks good, then click Keep This Configuration.

Does the display look OK?
The display will be reset to its previous configuration in 26 seconds

Restore Previous Configuration Keep This ConFiguration

6. Close the Displays dialog by clicking on the red X in the upper left.
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VirtualBox Shared Folders

Once Guest Additions have been installed, you must select a folder to share between the host and guest
systems. This folder is used to transfer files to/from the Virtual Machine and the Host system.

1. From the VirtualBox main menu, select Devices > Shared Folder > Shared Folders Settings...

@ Optical Drives 3
g Audio »
@ Network 8
& UsB ’
@ Webcams 3
(& Shared Folders * |[@@ Shared Folders Settings...
[C] Shared Clipboard ]
(84 Drag and Drop L
= & Insert Guest Additions CD image...

2. Right-click Machine Folders and select Add Shared Folder.

g General Shared Folders

(& system | Shared Fuiders
[ Marne Path Auto-mount  Access ﬁ
IEI Dlspla:.r .

| Machenn Ealdaer | i
Ej Storsge Transies (68  Add Shared Folder Ins [ ]

B sudic
'Ll-j'] Metwork
{98 Serial Ports
& use

[,d Shared Folders |

| E User Interface
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3. Inthe Folder Path box, click the dropdown arrow on the right. Select the Other entry to open a
Windows Explorer pane. Browse to the location in Windows where you want to set up a shared
folder and click Select Folder in the Explorer pane. Click the checkboxes for Auto-mount and
Make Permanent. Click the OK button. If the dialog asks for a “Mount point,” you may leave

that blank.
r ™ F ki
{5 Add Share R {53 Add Share 2 [
Folder Path:  <not selected > H Folder Path: C:\VirtualBox_Share -
Folder Name: =not selectad > Folder Name: VirtualBox_Share
Read-only [] read-only
[ Auto-mount | Auto-mount
[] Make Permanent | Make Permanent

oK [ ok || conel

4. The location of the shared folder in Windows is shown in the Path column. The folder will
Auto-mount and Full Access is allowed. The corresponding folder in the Linux VM is
/media/sf_<Windows Folder Name>. In the example shown, this corresponds to:

/media/sf_VirtualBox_Share

Click the OK button to close the panel.

t+3 Ubuntu PetaLlinux 2017.2 - §

General Shared Folders

System Folders List

Mame Path Auto-mount  Access
4 Machine Folders

Storage |Virtua...5hare C:\VirtualBox_Share Yes Full
Transient Folders

Display

Audio

Metwork

Serial Ports

Use

Shared Folders

OB ®GYDRDEEMW

User Interface
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5. Shared folders are only available to user accounts that are also members of the group vboxsf.
This means the user account created earlier must be added to this group. This can only be done
in Ubuntu 16.04 from the command line. To view available groups and members, open a
Terminal window but selecting the Dash and then searching for Terminal. In a Terminal window
enter one or more of the following commands.

This command lists all groups:

\$ getent group

This command lists a specific group named vboxsf:

|'$ getent group vboxsf

To add an existing user to an existing group, in a Terminal enter the following command and
then provide the password:

\$ sudo usermod -a -G vboxsf training

6. Reboot the Virtual Machine.

7. The selected user name will belong to the vboxsf group on the next login. To access the shared
folder from the Virtual machine, browse to: /media/sf_<sharename>

In this example, the folder in Windows is named VirtualBox_Share, so the <sharename> in Linux
is sf_VirtualBox_Share, automatically mounted in the /media folder. Any files in this folder are
available to the Virtual Machine and the Host OS system.

@ Ubuntu Petalinux 2017.2 [Running] - Oracle VM VirtualBox

Thunar File Manager

sf_VirtualBox_Share - File Manager

¢ P €D |[& /media/sf VirtualBox_Share/

DEVICES
1 File System
[
__| sf_VirtualB...

>

PLACES

@ training
@ Desktop

= Trash
P}
i) Documents

@ Music

ifim| Pictures

g Videos
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VirtualBox Shared Clipboard

Once the Guest Additions have been installed, you can enable the Shared Clipboard which will make it
easier to copy and paste text strings from tutorial documents from the host system to the guest
systems. This is very useful for later tutorials where it is desirable to copy command prompt instructions
verbatim from the tutorial guide document directly into the command prompt of the guest system.

1. From the VirtualBox main menu, select Devices > Shared Clipboard > Bidirectional

rﬁ Ubuntu Petalinux 2017.2 [Running] - Oracle VM VirtualBox l =R g
File Machine View Input [Del.r'rces] Help
Ubuntu Desktop Optical Drives ty B] = o) 9a5am %
Metwork
use

Webcams

Shared Folders

Shared Clipboard Disabled

Drag and Drop Host To Guest
Insert Guest Additions CD image... il

Bidirecticnal

H O 6 @

=

H:-“ﬁ

—_—

P o = @ {0 @ (8] rightctl
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Network Bridging

When VirtualBox is installed with its default options, the networking is set up to use Network Address
Translation (NAT). This allows your Virtual Machine complete outgoing access to your LAN and/or the
Internet, but it assigns an internal IP address that may not be compatible with your LAN and the IP

address of your host system.

If you would like your Virtual Machine to accept an address from a local DHCP server, you can change
the default network type to Bridged. This will make the Virtual Machine available to any other
connected device on the same subnet on your LAN.

1. From the main VirtualBox menu in a running Virtual Machine, click on the Settings button. If the
button is not visible, select Machine > Settings.

¥ Oracle VM VirtualBox Manager

[File Machine Help

@@ OD
e
INmu

Settngs Dwcard  Show

2. Select the Network entry in the left panel. Select the tab for your NIC (typically Adapter 1) and
expand the dropdown menu for the Attached to field.

{23 Ubuntu Petalimux 201 - Settings e
|
| 5 Garveral M b
ur
I -_"Jirm"" Sciapter | | Adspser 2 | Adepter 3 | Adscter 4
| % Display o | Erushis Hebvenric Adagier
1 dﬁ] Storage Axtached So: ;Dr-dn-edMap-'.u' "'i
w0t artiacred
R Mame! | pat AL 7360 -
| | Audic ) AT P bwari
b Acvenced Bracioed e
mr  Metwork Ervimrriall N twoork
- Hest-only Adaciter
1;3: Serial Poats AL
.f-} (1.3
'_-_l Shared Folders
I!'_-'I Uker Interface
[ox ][ conce
=4

3. Select Bridged Adapter from the dropdown menu and click the OK button to save the changes.
Wait a few seconds for your Virtual Machine to request an address from the local DHCP server.
Once complete, the VM will now have an address on your local subnet, accessible to all devices

on your LAN.

If you do not receive a new IP address after a minute, stop and restart the Ethernet service.
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Configuring Ubuntu 16.04

Configuring Ubuntu on a supported Virtual Machine should be straightforward, but there could be some
additional steps needed to create an optimal environment. This section outlines a few of the common
issues that may be encountered.

Set a root user password

By default, Ubuntu does not set a password for the root user. You can do this by simply invoking the
sudo passwd command. You supply your own user password, then set the root user password.

sudo passwd

<Enter user password>

<Enter new root password>
<Confirm new root password>

training@training-virtualBox:~$ sudo passwd
[sudo] password for training:
Enter new UNIX password:

Retype new UNIX password:
passwd: password updated successfully

From this point forward, you will be able to precede a command with sudo to obtain root authority.
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Change the default shell to bash for PetaLinux

If you intend to use the Petalinux tool-chain under Ubuntu, you will find that it requires the bash shell
as the default to execute correctly. By default, Ubuntu uses the dash shell, which is an extension of the
bash shell with a few additional features and optimized for faster execution. Unfortunately, the dash
shell is not compatible with the current Petalinux tool-chain.

A description for the dash shell and its potential issues can be found here:
https://wiki.ubuntu.com/DashAsBinSh

1. Most distributions use /bin/sh as a symbolic link to points to the actual default shell. Under your
Ubuntu environment, to determine the current shell, enter:

[$ Is -1 /bin/sh

2. To change the default shell for all terminal windows, enter:

\$ sudo dpkg-reconfigure dash

3. Select the option to remove dash as the default shell when prompted.

training@training-VirtualBox: ~
Package configuration

{ Configuring dash |

The system shell is the default command interpreter for shell scripts.

Using dash as the system shell will improve the system's overall
performance. It does not alter the shell presented to interactive users.

Use dash as the default system shell (/bin/sh)?

<Yes>

4. When the change is complete, close all open Terminal windows and open a new Terminal.

5. Verify the default shell is bash using the commands shown previously.

2

training@training-VirtualBox: ~
training@training-VirtualBox:~5 1s -1 fbin/sh

Llrwxrwxrwx 1 root root 4 Apr 13:29 [bin/sh -> bash
training@training-VirtualBox:~
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Xilinx Vivado/SDK Installation

Installing Vivado/SDK tools on a supported Linux system should be straightforward but depending on
the precise configuration of your development system, there could be some challenges to create an
optimal environment. This section outlines a few of the common issues that may be encountered.

To perform the steps in this section, you need to download a tar.gz image to your host system. The most
recent images can be downloaded from: http://www.xilinx.com/support/download.html.

NOTE: Once the download is complete, you may want to verify there is an md5sum utility installed by
default. Open a terminal window and enter the following:

\$ md5sum -b <path to your compressed-Vivado-tar.gz fTile>

The valid checksums for the different download archives are available from the Xilinx download site.
Install Vivado in the VirtualBox Linux VM

1. Copy the All-OS version of the compressed Vivado or SDSoC installer from your host system to
your VM desktop from the file share. Do NOT attempt to install from the file share location.

(2018.3 SDx installer shown below)
E

Hilinse_S0h_
2018.3_1207
_2324.tar.gz

2. Open aterminal window and decompress the installer on your desktop. It will create a new
folder automatically in the current directory of your Terminal window.

\$ tar -xvzf ~/Desktop/<Compressed-Vivado-Installer-Name>

3. Change into the new folder and execute the installer setup script. You will need root privilege to
install into the default directory of /tools/Xilinx (preferred).

$ cd ~/Xilinx_Vivado_SDK_2018.3_1207 2324/
-0OR-

$ cd ~/Xilinx_Vivado_SDx_2018.3_1207 2324/
$ sudo ./xsetup
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4. The Vivado 2018.3 Installer lists the operating systems officially supported by Xilinx. The tools
may run on other Linux distributions and versions, but there will likely be some manual
configuration required. Installation on unsupported systems is beyond the scope of these notes.

SDx IDE 2018.3 Installer - Welcome

SDx

©IDE

Welcome

We are glad you've chosen Xilink as your development target. This program can install the SDx Development
Environments.

Supported operating systems for SDx 2018.3 are:

- Windows 7.1: 64-bit (SDSoC only)

- Windows 10 Professional versions 1803 and 1809: 64-bit (SDSoC only)

- Red Hat Enterprise Linux 6.6-6.9: 64-bit (SDSoC only)

- Red Hat Enterprise Linux 7.2-7.3: 64-bit (SDSoC only)

- Red Hat Enterprise Linux 7.4-7.5: 64-bit

- Cent0S Linux 6.6-6.9: 64-bit (SDSoC only)

- Cent0S Linux 7.2-7.3: 64-bit (SDSoC only)

- Cent0S Linux 7.4-7.5: 64-bit

- Ubuntu Linux 16.04.4 and 18.04 LTS: 64-bit - Additional library installation required

Note: This release requires upgrading your license server tools to the Flex 11.14.1 versions. Please confirm
with your license admin that the correct version of the license server tools are installed and available, before
running the tools,

To reduce installation time, we recommend that you disable any anti-virus software before continuing.

& XILINX.
Copyright @ 1986-2018 Xilink, Inc, All rights reserved,
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5. Follow the instructions as shown in the Installer GUI.
Note: If installing Vivado, if you also want to install the SDK, select SDK Development Kit from
the menu.
a. Accept all license agreements.
b. Select the Vivado edition (version) you wish to install (or SDK Standalone).
c. Select the Devices you need.
i. If choosing SDSoC, you can deselect SDACCEL
d. Cable Drivers are no longer installed by this installer under Linux. See instructions in the
Install Missing Cable Drivers section of this document.

SDx IDE 2018.3 Installer - SDx Development Environments

SDx Development Environments

Customize your installation by (de)selecting items in the tree below. Moving the cursor over the selections below XI LI .;
provides additional information.

Choose the right devices for your target device. SDSoC = Zyng-7000 and Ultrascale+ MPSoC, SDAccel = 7 Series, Ultrascale, Ultrascale+
PCle cards with an external host (e.g. x86)

¢ 6 Design Tools
o [m] Software Defined Development Environment (SDx) IDE for SDSoC and SDAccel
y Dochav
7 il Devices
Built-in Platforms and associated devices for SDSocC
[] Built-in Platforms and associated devices for SDAccel
Devices for Custom Platforms
SoCs
7 Series
(]

-

UltraScale
[¥] UltraScale+
[] Engineering Sample Devices for Custom Platforms
stallation Options
[0 MOTE: Cable Drivers are not installed on Linux Please follow the instructions in UGS73 to install Linux cable drivers
Acquire or Manage a License Key
Enable WebTalk for SDx and Vivado to send usage statistics to Xilink (Always enabled for WebPACK license)
Enable WebTalk for SDK to send usage statistics to Xilinx

o
o
o
o

¢ f

=)

Download Size: NA Reset to Defaults
Disk Space Required: 50,93 GB

Copyright @ 1986-2019 Xilinx, Inc. All rights reserved. | = Back || Mext = || Cancel |

e. Select the default directory for installation. Depending on the size of your virtual disk,
you may be space limited here. You can delete the compressed installer archive to free
20-25 GB of disk space, if necessary.

f. If needed for your device or tool selection, obtain and install a license for your tools. If
you are planning to use a free WebPACK license for development on your target
platform, there is nothing further that is needed and you can close the Vivado License
Manger dialog.

6. You may optionally delete the entire folder where you decompressed the installer to free up
additional disk space.
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Adjust GTK Version Used for Vivado in the VirtualBox Linux VM

It is a known issue that SDK will fail to launch on Ubuntu 16.04 without a workaround and this is
addressed in Xilinx Answer Record AR67580:

https://www.xilinx.com/support/answers/67580.html

The issue is with the GTK version shipped with Ubuntu 16.04, which has issues with the eclipse. In order
to work around this issue, set the environment variable SWT_GTK3 to 0.

1. Totemporarily set this environment variable for the current terminal session, use the following
command:

|'$ export SWT_GTK3=0

2. To permanently set this environment variable for the all future terminal sessions, insert this
comment and export command near the top of the ~/.bashrc file using your favorite editor:

# This is a workaround for Xilinx SDK and GTK incompatibility.
export SWT_GTK3=0

-~ =

training@training-VirtualBox: ~

# ~/.bashrc: executed by bash(1) for non-login shells.
# see [usr/share/doc/bash/examples/startup-files (in the package bash-doc)
# for examples

# This is a workaround for Xilinx SDK and GTK incompatibility.
export SWT GTK3=0

# If not running interactively, don't do anything
case 5- in
*¥*)
*) return;;
esac

# don't put duplicate lines or lines starting with space in the history.
# See bash(1) for more options
HISTCONTROL=1gnoreboth

# append to the history file, don't overwrite it
shopt -s histappend

# for setting history length see HISTSIZE and HISTFILESIZE in bash(1)
HISTSIZE=1000

HISTFILESIZE=2000

".bashrc" 120 lines, 3853 characters

3. Save the edits to the ~/.bashrc file.
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Create Symbolic Link for gmake

Itis a known issue that SDK can fail to build, and by extension SDSoC’s compiler flow, when using
Ubuntu 16.04. Using the below workaround we can address this issue. It is also addressed more
generically in Xilinx Answer Record AR68344:

https://www.xilinx.com/support/answers/68344.html

The issue is that Ubuntu does not include gmake by default, while make IS included.

1. To permanently set this we will create a symbolic link. As this will become permanent, we will
not have to perform any further modifications.

\$ sudo In -s /Zusr/bin/make /usr/bin/gmake

gmake: command not found
training@training-vb:~/projects$ make
make: *** No targets specified and no makefile found. Stop.

training@training-vb:~/projects$ sudo 1n -s fusr/bin/make /fusr/bin/gmake
[sude] password for training:
training@training-vb:~/projects$ |}

As you can see from the above image, gmake does not exist on this install, while make does.
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Install GTK Terminal

The Ubuntu Serial port terminal (or GTK Terminal) application is used in some of the Avnet Reference
Designs and Tutorial materials since it allows for simple connection to USB-UART of many development
board platforms.

1. Pluginyour development board and connect the USB-UART port to the PC so that the USB-
UART device is recognized under Windows first. Then locate your USB-UART device under the
Devices>USB selection menu and click on it to remove the device from the host operating
system and add it to the guest operating system. In this example the Digilent USB Device [0900]
device is used as it represents the USB-UART of the Avnet MiniZed board.

e —
Fag Ubuntu Petallinux - essentials) [Running] -

File Machine View Input | Devices | Help

Termina' Terminal File RN

Audio

Metwork

UsB (&3 USB Settings...
Webcams
Dell USB Keyboard Hub [4800]

Shared Folders Generic USB2.0-CRW [8197]
Shared Clipboard Digilent USB Device [0900]
Drag and Drop Vender ID: 0403

Product ID: 6014
Insert Guest Additiens CD image... Revision: 0900

Serial No. 210299956010
| State: Busy

2. Once the device is detected and enumerated under Ubuntu, the USB-UART port should be listed
under one of the /dev/ttyUSBx device entries. Locate the device entry for the USB-UART and
make a note of this device for use in a later step.

\$ Is /dev/ttyUSB*

o

training@training-VirtualBox: ~
training@training-VirtualBox:~S 1ls fdev/ttyUSB*

Jdev/ttyuUsBe [dev/ttyUSB1
training@training-virtualBox:~$ |J

3. To make it easier to launch the terminal app (GtkTerm) without needing to provide the root
password each time, open a command window and add the current user to the group for the
/dev/ttyUSBx devices used for USB-UART:

| $ sudo usermod -a -G dialout training

4. Install the gtkterm package:

\$ sudo apt-get install gtkterm

ANVNET

Reach Further™ 42 May 2019



VirtualBox and VM Creation Xilinx Vivado®/SDK/PetaLinux/SDx 2018.3

5. Reboot the Virtual Machine to force the changes to take effect.

6. Create a Desktop icon by copying and pasting Serial port terminal (gtkterm) application from
the /usr/share/applications folder directly to the ~/Desktop folder:

&8 B
Serial port Shotwell H
terminal
Execute
@_ Open With ’
Send To ’
Software
Updater
Copy
j |
System Lo¢
ﬁ Properties...

7. Right-click on the new Serial port terminal (gtkterm) application Desktop icon and select the
Properties option.

8. Within the Properties window, set the app attributes to match the USB-UART device attached to
the system, in this example the USB-UART is attached to the /dev/ttyUSB1 device entry:

Name: Serial port ttyUSB1
Command: gtkterm -p /dev/ttyUSB1 -s 115200

8 Serial port ttyUSB1 Properties

Basic | Permissions

[:_w Name: Serial port ttyUSB1

— ' Description:

Command: | gtkterm -p /dev/ttyUSB1 -5 115200

Comment: | Communicate with the serial port ‘
Type: desktop configuration File (applic...
Size: 242 bytes

Location: Jhome/training/Desktop

Accessed: Mon, Apr 17 2017 13:03:17
Modified: Mon, Apr 17 2017 13:03:17
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9. Close the Properties window.

Install Missing Cable Drivers

The drivers, which were not included with the install, can be installed manually.
1. Open a Terminal window.

2. At the command prompt, enter:

$ cd
/tools/Xilinx/Vivado/2018.3/datasxicom/cable_drivers/lin64/insta
Il _script/install _drivers/

$ sudo ./install _drivers

@ ™ @ training@training-vb: ftools/Xilinx/Vivado/2018.3/data/xicom/cable_drivers/lin64/insta

INFO: Installing cable drivers.

INFO: Script name = ./install_drivers

INFO: HostMame = training-vb

INFO: Current working dir = ftools/Xilinx/vivado/2018.3/data/xicom/cable_drivers
/lin64/install_script/install_drivers

INFO: Kernel version = 4.15.8-43-generic.

INFO: Arch = x86 _64.

successfully installed Digilent Cable Drivers

--File fetcjudev/rules.d/52-xilinx-ftdi-usb.rules does not exist.
--File version of Jetc/udev/rules.d/52-xilinx-ftdi-usb.rules = 00EO.
--Updating rules file.

--File fetc/udev/rules.d/52-xilinx-pcusb.rules does not exist.
--File version of fetc/udev/rules.d/52-xilinx-pcusb.rules = 0000.
--Updating rules file.

INFO: Digilent Return code = @

: Xilinx Return code = @

: Xilinx FTDI Return code = @

: Return code = @

: Driver installation successful.
CRITICAL WARNING: Cable(s) on the system must be unplugged then plugged back in
order for the driver scripts to update the
training@training-vb: ftools/Xilinx/Vivado/: ata/xicom/cable_drivers/lin64f
install_script/install_driverss JJ
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Vivado and SDK Permission Issues

When you invoke Vivado, you may see the following error message, indicating a permission issue in the
directory hierarchy:

training@training-VirtualBox fopt/Xilinx/Vivadof201  fdata/xicomfcable_drivers/linga

CRITICAL WARNING: [Common 17-T41]) hu wri ACCess rlqht to thﬂ local T;I rturn:- a
train ; 5 .

.aunLh vivado.
257] Failed to create directory 'jJopt/Xilinx/vivade/2016.4ftc

save the Vivado user preferences file. Reason: 'fhomeftraining/
a.inl (Permi denied)’

shortcut directory: 'fhome/training/.Xilinx/Vivado/2016.4/3

the layout directory: '/[fhome/training ilinx/vivadof2016.4/lay

e the commands directory: 'Jhome/training/.Xilinx/Vivado/2816.4/cC

create the layout directory: 'Shome/training/.Xilinx/Vivado/2016.4/lay

fhome/training/.profile
ivado user preferences f11|.= Reason: " fhomeftraining/

' fhome /trainingf

This indicates that the hidden folder named .Xilinx, where license and configuration information is
stored, is read-only for the invoking username. One method to correct this is to change ownership of the
directory hierarchy using root authority.

1. Change to the directory above the .Xilinx folder, which in this case is the fhome/training folder.
Enter the following commands:

cd
sudo chown training -R _Xilinx
sudo chgrp training -R _Xilinx

LR

2. Run the Xilinx Vivado and SDK 64-bit environment settings scripts in a terminal window to setup
the environment path to the tools install folder so that Vivado and SDK can be located in the
next steps.

$ source /tools/Xilinx/Vivado/2018.3/settings64.sh

$ source /tools/Xilinx/SDK/2018.3/settings64.sh
Optional if using SDSoC

$ source /tools/Xilinx/SDx/2018.3/settings64.sh
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3. Launch Vivado or the SDK as usual using the fixed permissions on the .Xilinx folder.

To start Vivado from a Terminal window, enter the following command:

‘$ vivado &

To start the Xilinx SDK from a terminal window, enter the following command:

| $ xsdk &

If you installed SDSoC and you want to start the Xilinx SDSoC from a terminal window, enter the
following command:

\$ sdx &
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Install Missing Desktop Icons

In some cases, Vivado and/or SDK desktop icons may be missing. These can be manually added
using some launcher shell scripts and by adding some desktop icon entries.

1. Change to the home directory for the current user.

[$ cd ~

2. Using your favorite text editor edit a new shell script named vivado_launch.sh

[$ gedit vivado_launch.sh

Paste the following text into that script file, save the contents and exit. This creates a script that
is capable of invoking the settings script needed for Vivado to launch correctly.

#1/bin/bash
. /tools/Xilinx/Vivado/2018.3/settings64.sh
vivado &

3. Using your favorite text editor edit a new shell script named sdk_launch.sh

| $ gedit sdk_launch.sh

Paste the following text into that script file, save the contents and exit. This creates a script that
can invoke the settings script needed for Xilinx SDK to launch correctly.

#1/bin/bash

# This 1s a workaround for Xilinx SDK and GTK incompatibility.
export SWT_GTK3=0

. /tools/Xilinx/SDK/2018.3/settings64.sh

xsdk &
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4.

If you have installed SDSoC, using your favorite text editor edit a new shell script named
sdx_launch.sh
Otherwise skip to the next step

\$ gedit sdx_launch.sh

Paste the following text into that script file, save the contents and exit. This creates a script that
can invoke the settings script needed for Xilinx SDK to launch correctly.

#1/bin/bash

# This is a workaround for Xilinx SDK and GTK incompatibility.
export SWT_GTK3=0

. /tools/Xilinx/SDx/2018.3/settings64.sh

sdx &

Change permissions of both launcher scripts so that they can be executed.

$ chmod u+x vivado_launch.sh
$ chmod u+x sdk_launch.sh

-— Optional if using SDSoC --
$ chmod u+x sdx_launch.sh

Change directories to the home Desktop folder of the current user.

\$ cd ~/Desktop
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7. Using your favorite text editor edit a new file named Vivado.desktop

\$ gedit Vivado.desktop

Paste the following text into that script file, save the contents and exit. This creates a desktop
launcher icon that can invoke the Vivado launcher script created in earlier steps.

#1/usr/bin/env xdg-open

[Desktop Entry]

Version=1.0

Type=Application

Terminal=false

Exec=/home/training/vivado_launch.sh

Name=Vivado 2018.3

Comment=Xilinx Vivado Design Suite 2018.3
Icon=/tools/Xilinx/Vivado/2018.3/doc/images/vivado_logo.ico
StartupNotify=true

8. Using your favorite text editor edit a new file named SDK.desktop

\$ gedit SDK.desktop

Paste the following text into that script file, save the contents and exit. This creates a desktop
launcher icon that is capable of invoking the Xilinx SDK launcher script created in earlier steps.

#1/usr/bin/env xdg-open

[Desktop Entry]

Version=1.0

Type=Application

Terminal=false

Exec=/home/training/sdk_launch.sh

Name=Xilinx SDK 2018.3

Comment=Xilinx Software Development Kit 2018.3
Icon=/tools/Xilinx/SDK/2018.3/data/sdk/images/sdk_logo.ico
StartupNotify=true
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9. If using SDSoC, using your favorite text editor edit a new file named SDX.desktop
Otherwise, skip to the next step

\$ gedit SDX.desktop

Paste the following text into that script file, save the contents and exit. This creates a desktop
launcher icon that is capable of invoking the Xilinx SDK launcher script created in earlier steps.

#1/usr/bin/env xdg-open

[Desktop Entry]

Version=1.0

Type=Application

Terminal=false

Exec=/home/training/sdx_launch.sh

Name=Xilinx SDx 2018.3

Comment=Xilinx SDSoC Development Kit 2018.3
Icon=/tools/Xilinx/SDx/2018.3/docs/images/sdx_icon.ico
StartupNotify=true

10. Change permissions of both launcher scripts so that they can be executed.

$ chmod u+x Vivado.desktop
$ chmod u+x SDK.desktop

-— Optional if using SDSoC --
$ chmod u+x SDX.desktop

Once the execution permission is changed, the icons will populate on the Desktop with the
correct graphics. Note that SDx is optional.

>4

Vivado 2018.3

SDK

Xilinx SDK 2018.3

SDx

Xilinx SDx 2018.3
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PetaLinux Installation

Installing PetaLinux tools on a supported Linux system should be straightforward but depending on the
precise configuration of your development system, there could be some challenges to create an optimal
environment. This section outlines a few of the common issues that may be encountered. For more
information on the installations of PetalLinux tools, please refer to Xilinx User Guide UG1144.

TFTP Server Install and Setup

1. Install the following packages:

\$ sudo apt-get install xinetd tftpd tftp

2. Create /etc/xinetd.d/tftp and put this entry:

service tftp

{

protocol = udp

port = 69
socket_type = dgram
wait = yes

user = nobody
server = /usr/sbin/in_tftpd
server_args = /tftpboot
disable = no

}

3. Create a tftpboot folder, this should match what is in the server_args, and assign read/write
permissions with the following command:

$ sudo mkdir /tftpboot
$ sudo chmod ugo+rw /tftpboot/

4. Restart the xinetd service.
For new systems:

[ $ sudo service xinetd restart

For older systems:

| $ sudo /etc/init.d/xinetd restart

Now our tftp server is up and running.
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Install openssl Libraries for PetaLinux

As of 2015.2, the PetalLinux tools require the openssl libraries on the host system which can be installed
under Ubuntu using the following command:

\$ sudo apt-get --yes install libssl-dev

Install Additional System Tools and Library Dependencies for PetalLinux

According to Xilinx User Guide UG1144, Petalinux 2018.3 tools require some additional system tools and
libraries to be installed on the host system. For exact system dependencies, refer to UG1144 document.

If you are using Ubuntu, this can be accomplished in a terminal window with the following command:

$ sudo apt-get --yes install tofrodos iproute gawk gcc git-core make
net-tools libncurses5-dev tftpd zliblg-dev flex bison 1ib32z1
lib32ncurses5 lib32ncursesw5 Bib32gompl xvfb chrpath socat autoconf
libtool texinfo gcc-multilib libsdll.2-dev libglib2.0-dev
zliblg:1386 fTilezilla

Adjusting Permissions of Vivado and PetalLinux Install Folder

As of 2018.3, Petalinux tools require the installation as a non-root user so the permissions of these
folders under the /opt folder must be adjusted accordingly.

This can be accomplished in a terminal window with the following commands:

sudo chmod ugo+w /tools/

sudo mkdir /tools/petalinux-v2018._3-final

sudo chmod -R ugo+w /tools/Xilinx

sudo chmod -R ugo+w /tools/petalinux-v2018.3-final

sudo chown -R training:training /tools/petalinux-v2018.3-final
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Install Petalinux into /opt/petalinux-v2018.3-final Folder

The Petalinux 2018.3 Installer (TAR/GZIP - 6.15 GB) takes about 1.5-4 hours depending on the download
speed. The file can be downloaded here:

https://www.xilinx.com/support/download/index.html/content/xilinx/en/downloadNav/embedded-
design-tools/2018-3.html

1. Copy the Petalinux installer from your host system or Downloads folder to your VM desktop.

petalinux-v2018.3-
final-installer.run

2. Open a terminal window and launch the installer while specifying the target install folder.

$ cd ~/Desktop
$ ./petalinux-v2018.3-final-installer.run /tools/petalinux-
v2018.3-final

3. The Vivado 2018.3 Installer will take several minutes to verify the integrity of the packed
installer and then extract itself.

4. Read the Petalinux license agreements and, if you can accept the license conditions, press enter
to view the license, use keyboard page up/down keys to scroll through the agreement, press
the q key to quit viewing the agreement when finished, and press the y key if you accept the
license conditions. If prompted, allow the installer to make changes to your development
system.

@ S @ training@training-VirtualBox: ~/Desktop

INFO: Checking installer checksum...
INFO: Extracting PetalLinux installer...

LICENSE AGREEMENTS

PetaLinux SDK contains software from a number of sources. Please review
the following licenses and indicate your acceptance of each to continue.

You do not have to accept the licenses, however if you do not then you may
not use PetalLinux SDK.

Use PgUp/PgDn to navigate the license viewer, and press 'g' to close

Press Enter to display the license agreementsy
Do you accept Xilinx End User License Agreement? [y/N] > y
Do you accept Webtalk Terms and Conditions? [y/N] > y
Do you accept Third Party End User License Agreement? [y/N] > y
: Checking installation environment requirements...
: Checking free disk space
: Checking installed tools
: Checking installed development libraries
: Checking network and other services
: Installing PetalLinux...
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5. Be sure to source the /tools/petalinux-v2018.3-final/settings.sh script prior to attempting to
use the Petalinux tools for development.

\$ source /tools/petalinux-v2018.3-final/settings.sh

6. To permanently set this environment variable for the all future terminal sessions, insert this
comment and export command near the top of the ~/.bashrc file using your favorite editor:

# This automatically sets up the PetalLinux tools environment.
source /tools/petalinux-v2018.3-final/settings.sh

* bashrc (~f) - gedit

Open ¥ [+l

# ~/.bashrc: executed by bash(1) for non-legin shells.
# see fusr/share/doc/bash/examples/startup-files (in the package bash-doc)
# for examples

# This is a workaround for Xilinx SDK and GTK incompatibility.
export SWT GTK3=0

# This automatically sets up the Petalinux tools environment.
source ftoolsfpetalinux-v2018.3-finalfsettings.sh

# If not running interactively, don't do anything
case 5- 1in
*i¥) 55
*) return;;
esac

7. Save the edits to the ~/.bashrc file.

IAVNET

Reach Further™ 54 May 2019



VirtualBox and VM Creation Xilinx Vivado®/SDK/PetaLinux/SDx 2018.3

Licensing Xilinx Tools

If you have a need to license the Vivado tools installed on your virtual machine to handle other Xilinx
devices or IP Cores that are not covered by the free Xilinx WebPACK License, you may need to perform
the workaround outlined in Xilinx Answer Record 60510:

https://www.xilinx.com/support/answers/60510.html

There is also some additional, distribution specific, guidance provided in this Element14 Community
Forum Post.

https://www.elementl4.com/community/message/255989/I/running-vivado-on-a-centos-7-virtual-
machine#255989

This limitation of the licensing tool being able to read the MAC ID from the modern Ubuntu Ethernet
interface naming conventions will likely be fixed in a future release of the Xilinx tools.

To launch the Xilinx license manager in Linux, do the following:
1. Launch Vivado
2. Click Help > Manage License...
3. Click View Host Information to see how Vivado is interpreting your host information
4. Click Obtain License if you need to generate a free WebPACK license (3™ radio button) or
redeem a voucher (4" radio button)
Linux will launch Mozilla Firefox
6. Enter your Xilinx login information and continue with the Licensing according to Xilinx
instructions.
7. Once the license is generated and downloaded, you will need to click Load License in the License
Manager and point to the downloaded license file.

o
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Install Avnet Board Definition Files

As stated in Xilinx UG895:
The Vivado Design Suite lets you create projects using Xilinx target design platform boards
(TDP), or user-specified boards that have been added to a board repository. When you
select a specific board, the Vivado design tools show information about the board, and
enable additional designer assistance as part of IP customization, and for IP integrator
designs.

User-specified boards, like the ones from Avnet, are added to the Vivado Design Suite using board
definition files. To install the Avnet BDFs, do the following:

1. Open the Firefox browser by clicking on the icon
Navigate to https://github.com/Avnet/bdf
3. Scroll down until you see

N

Detailed Instructions for Installing Files Under Ubuntu without using Git

4. Follow the instructions.
5. Browse to /tools/Xilinx/Vivado/2018.3/datasboards/board_files, sort by
Modified date and verify you see something like below.

tools Xilinx Vivado 2018.3 data boards board_files

Mame Size Type Modified
‘ ultrazed_7ev_som_es2 1item Folder May6
‘ ultrazed 7ev_som 1item Folder May6
‘ ultrazed_7ev_cc_es2 1item Folder Mayé6
d ultrazed_7ev_cc 1item Folder May6
d ultrazed_3eg_som_es1 1item Folder May6
‘ ultrazed_3eg_som 1item Folder May6
‘ ultrazed 3eg_pciecc_es1 1item Folder May6
‘ ultrazed_3eg_pciecc 2items Folder Mayé6
ox_Share E d ultrazed_3eg_iocc_es1 1item Folder May6
d ultrazed_3eg_iocc 1item Folder May6
‘ ultra9evz 1item Folder May6
el f ‘ ultragevi 1item Folder May6
== d picozed_7030_som 1item Folder Mayé6
d picozed_7030_fmc2 1item Folder May6
d picozed 7020_som 1item Folder May6
‘ picozed_7020_fmc2 1item Folder May6
‘ picozed 7015 som 1item Folder May6
d picozed_7015_fmc2 1item Folder Mayé6
d picozed_7010_som 1item Folder May6
d picozed_7010_Ffmc2 1item Folder May6
‘ minized 1item Folder May6
‘ microzed 7020 1item Folder May6
d microzed_7010 1item Folder Mayé6
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6. You can also double-check in Vivado. Launch Vivado.

Create a a new RTL Project.

8. Atthe Default Part dialog, select Boards, then change the Vendor to em.avnet.com. You should
see a number of boards, similar to what you see below.

> New Project

Default Part

Choose a default Xilinx part or board for your project. ‘

N

Mame: | All Remaining ~ Board Rew: | Latest w

Search: Q- w
Display Name Preview Wendor File Version Part
MicroZed 7010 Board oy

em.avnet.com 1.2 ®c7z010clg400-1
MicroZed 7020 Board

em.avnet.com 1.2 ¥c7z020clg400-1
MiniZed

em.avnet.com 1.2 ®c7z007sclg225-1
PicoZed 7010 SOM + FMC Carrier W2

em.avnet.com 1.2 %c7z010clg400-1
PicoZed 7010 SOM

em.avnet.com 1.2 ®c7z010clg400-1
PicoZed 7015 SOM + FMC Carrier W2

em.avnet.com 1.2 ®c7z015¢clg485-1
PicoZed 7015 SOM

em.avnet.com 1.2 ®c7z015¢clgd85-1
PicoZed 7020 SOM + FMC Carrier W2

em.avnet.com 1.2 #c7z020clg400-1
PicoZed 7020 SOM ~
< >

Fay
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1.8 August 2018 Updated for PetaLinux 2018.2 and Xilinx
Vivado/SDK/SDSoC 2018.2 tools; added cumulative
download section

1.9 January 2019 Updated for PetaLinux 2018.3 and Xilinx
Vivado/SDK/SDSoC 2018.3 tools, tools moved to new folder
Added AR relating to gmake (SDSoC critical)

1.10 March 2019 Added notes for disabling Hyper-V under Windows 10 and
allocating additional CPU cores for the VM

1.11 April 2019 Added additional info on setting Display resolution. Added
install of FileZilla. Verified with Windows 10. Updated hard
drive space to 300GB recommended.

1.12 May 2019 Add instructions to install Avnet board definition files from
GitHub
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